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Getting Started 
 

Welcome 

GoToMeeting’s “simpler is better” approach to online meetings makes it the easiest, fastest, 
most cost efficient and secure online presentation and collaboration service available. 

GoToMeeting users can collaborate on documents, deliver presentations, perform product 
demonstrations and securely share confidential information from anywhere, at any time.  
GoToMeeting’s rapid download, quick meeting setup, and intuitive user interface has meeting 
Organizers and Attendees up and running in a matter of seconds. 

GoToMeeting incorporates industry-standard security features and end-to-end SSL encryption 
to ensure that login information and meeting data are secure. The GoToMeeting architecture is 
the most advanced security foundation available on the market and offers meeting Hosts and 
Attendees true end-to-end data security. The high level of security provides a greater sense of 
safety to meeting participants and allows GoToMeeting users to confidently present and 
collaborate on any data. Users can rest assured that information such as sales forecasts, 
financial data and M&A contracts will not be viewable to anyone except meeting participants. 

With GoToMeeting, travel costs can be dramatically reduced or eliminated because meetings 
can be held online with anyone, anywhere. Spend time meeting online rather than traveling, 
getting through security or waiting in airports. 

GoToMeeting’s liberal All You Can Meet™ pricing model provides easy-to-understand billing 
that helps you effectively budget and manage online meeting costs with no unexpected 
“overage” charges or additional fees. 

A new breed in online meeting technology, GoToMeeting was designed to make it easier for 
everyone to organize and participate in online meetings. Make every meeting a GoToMeeting 
and get more meeting done. 
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Using This Guide 
 

Guide Structure 

This guide is divided into sections about each role associated with using GoToMeeting. The 
roles are Organizer, Presenter and Attendee. To use this guide, go to the section that applies 
to the role you are performing at the time.  

• Organizers create accounts, set up meetings and start meetings. During meetings the 
Organizer may be both a Presenter and an Attendee.  

• Presenters are Organizers or Attendees who are presenting their screens to others. 

• Attendees join meetings and may become Organizers or Presenters. 

A user may perform multiple roles at one time and roles can be switched at anytime during a 
meeting. 

Note: Learn more about these roles in the Terms section below. 

 

 

Personal and Corporate Users 

This user guide addresses both personal GoToMeeting users and GoToMeeting Corporate users. 
While most features apply to both audiences, some content relates to just one audience. To 
help you identify when something is just for one specific audience, this guide will clearly note 
the audience for any user-specific content. 

 

 

 

System Requirements 
 

For Organizers: 
! Required: Windows® 95, 98, Me, NT4.0, 2000, XP Home, XP Pro, 2003 Server 
! Required: Internet Explorer 5.0 or greater, or Netscape 6.0 or greater 
! Required: Stable 56k, cable modem, ISDN, DSL or better Internet connection 
! Recommended: Minimum of Pentium 300 with 64 MB of RAM 

For Attendees: 
! Required: Internet Explorer 5+ or Netscape 6+ 
! Required: Stable 56k, cable modem, ISDN, DSL or better Internet connection 
! Recommended: Java Virtual Machine enabled 
! Recommended: Minimum of Pentium 300 with 64 MB of RAM 

For Instant Messenger Integration: 
! GoToMeeting integrates with the most widely used instant-messaging applications. 

For Outlook Integration: 
! Microsoft® Outlook® 2000 or later 
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Terms 
 

• Organizer – Organizers have accounts with GoToMeeting that enable them to schedule 
and conduct meetings. Organizers are also the meeting Host and the initial meeting 
Presenter, but may pass the Presenter role to any other Attendee. Organizers have the 
ability to grant or revoke Attendee privileges, invite or dismiss Attendees during a 
meeting and make other Attendees Organizers. 

• Attendee – An Attendee is any person who attends a meeting. Organizers, Hosts and 
Presenters are all Attendees. By default, Attendees can view the Presenter's screen. An 
Attendee may remotely control the Presenter's computer screen if given the privilege. 
An Attendee may chat with other Attendees or view the Attendee List. 

• Presenter – A Presenter is any Attendee who is giving a presentation and shares his or 
her computer screen with all the Attendees. The initial Presenter is also the initial 
meeting Host. The Presenter also determines who gets to control the keyboard and 
mouse of the remotely viewed screen. 

• GoToMeeting Web Site – The Web site located at www.gotomeeting.com is used by 
Organizers to manage their accounts and host meetings and by Attendees to join 
meetings. 

• GoToMeeting System Tray Icon – The system tray icon is used to access Organizer 
features of GoToMeeting and to provide status of GoToMeeting service. To access 
Organizer features, right-click the system tray icon and select the desired feature. 

Icon Description 

 
GoToMeeting is Starting/Stopping – The application is starting up or shutting down. 
 When this icon is showing, the user will not have any menu options 

 
GoToMeeting is Connecting – The application is attempting to establish a connection 
with the server.  This icon is animated to look like it is “filling up”.  While connecting, 
the user has a very limited set of menu options (Help, About, Exit). 

 
GoToMeeting is Ready – A connection has been made, and the application is ready to 
use.  The user has all menu options available. 

 
GoToMeeting is Offline – A connection has been made, but there is some temporary 
network difficulty.  The user will still have all menu options available. 

 
GoToMeeting is Not Connected – A connection could not be established.  The user has 
a very limited set of menu options (Help, About, Exit). 

• Account Password – An account password is what Organizers use to log in to the 
GoToMeeting Web site. It must contain at least eight characters and include both letters 
and numbers. 

• Meeting Password – A meeting password is a unique computer access code that 
Organizers set up for each Host PC. It must contain at least eight characters and 
include both letters and numbers. Organizers use the access code every time they log in 
to a Host PC.  

• Viewer – The Viewer is the window displayed on the Attendees’ computers in which the 
Presenter’s PC desktop appears. The Viewer Window has its own title and menu bars. 

• Presenter’s PC Image – The Presenter’s PC image is the picture of the Presenter’s PC 
desktop that appears to Attendees in the Viewer Window. 
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Product Features 
 

• Intuitive User Interface: Easy-to-understand controls enable you to start and join 
meetings in seconds without training 

• Share Keyboard and Mouse Control: Securely collaborate on documents in real time 

• Instantly Change Presenters: Enable any participant to present to the entire group 

• Chat Window: Chat online with any participant in the meeting 

• Integration: Easily start or join GoToMeeting sessions through email or instant-
messaging applications 

• Attendee Authority: Grant and revoke attendee privileges before or during a meeting 
session 

• Reporting: Get detailed reports for trend analysis and ROI validation 

• True 24-Bit Color: Share presentations, graphics, pictures and PC applications with all 
meeting attendees in True 24-bit color. 

 

 

 

 

Feature Notes 
• Regular GoToMeeting Organizers are limited to 10 meeting Attendees, plus the 

Organizer, for a total of 11 people in each meeting. 

• Organizers using GoToMeeting Corporate may invite up to 25 meeting Attendees, for a 
total of 26 people in each meeting. 
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Organizing Meetings 
 

Organizer Role Overview 
Organizers have accounts with GoToMeeting that enable them to schedule and conduct 
meetings. An Organizer must be present at the start of any meeting as the meeting Host.  

Organizers need to first create their accounts and download the GoToMeeting software on their 
computers before they can schedule or conduct meetings.  

Organizers are responsible for creating scheduled meetings or starting impromptu meetings. 
Organizers invite Attendees and may do so via phone, email or instant message. 

Once a meeting starts, the Organizer becomes the meeting Presenter. During the meeting, the 
Organizer may pass the role of Organizer or Presenter to other Attendees. 

 

Create Your Organizer Account – Personal Plan Organizers 
Before they can schedule or start a meeting, first time Organizers need to create their 
GoToMeeting accounts and download the GoToMeeting software. It generally takes less than 2 
minutes to set up a GoToMeeting account. 

! To create your account 

1. Go to www.gotomeeting.com and click the Try It Now button. 

2. On the Create Account page, enter your information and click Create Account. 

3. On the Download GoToMeeting page, click the Download button. 

4. If prompted, click Yes or Grant to accept the download. 

5. Once the download is complete, click Start to begin the GoToMeeting software 
installation. 

6. Once the installation is complete, click Finish to finalize the process. 

 

Create Your Organizer Account –Corporate Plan Organizer 
If you are a GoToMeeting Corporate user you will be invited to join by your company’s 
GoToMeeting Administrator. Before being able to schedule or start a meeting you need to 
create your GoToMeeting account and download the GoToMeeting software. 

! To create your account 

1. Go to your email application and open the GoToMeeting invitation email you received 
from your administrator entitled Set Up GoToMeeting Corporate. 

2. In the email, click the activation link to create your Organizer account. 

3. On the Create Account page, enter your information and click Create Account. 

4. On the Download GoToMeeting page, click the Download button. 

5. If prompted, click Yes or Grant to accept the download. 

6. Once the download is complete, click Start to begin the GoToMeeting software 
installation. 

7. Once the installation is complete, click Finish to finalize the process. 
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The GoToMeeting Organizer Web Site  
The GoToMeeting Organizer Web site enables Organizers to view their scheduled meetings and 
meeting history and to edit their account information.  

Note: To schedule meetings, Organizers need to log in to the Organizer application. Please see the GoToMeeting 
Organizer Application section below for more on scheduling meetings. 

 

 

Log In to Your Organizer Web Site 

To access Organizer Web site features, Organizers must first log in. 

! To log in to your Organizer Web site 

1. Open an Internet browser and go to www.gotomeeting.com.  

2. In the left navigation bar, click Log In. 

3. In the Returning Users section, enter your email address and password and click the 
Log In button. 

You will be logged in to your Organizer Web site account and taken directly to the My 
Meetings page. 

 

 

View Scheduled Meetings 

The My Meetings feature enables Organizers to view any existing scheduled meetings. 

! To view scheduled meetings 

1. Log in to your Organizer Web site.  

2. The My Meetings page loads with a list of scheduled meetings showing meeting subject, 
start date and time. 

 

 

To return to the My Meetings page from another page, click My Meetings in the left 
navigation bar. 
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View Meeting History 

The Meeting History feature enables Organizers to view a report of completed meetings for a 
selected month. 

! To view meeting history 

1. Log in to your Organizer Web site. 

2. In the left navigation bar, click Meeting History. 

The Meeting History page loads, listing any completed meetings for the present month 
and giving the option to report on meetings from past months. 

3. In the Meeting History section, from the selection boxes select the Month and Year for 
the meeting period you want to review and click the Update History button. 

The Meeting History section updates and displays the subject, date/time, duration and 
number of Attendees for all completed meetings for the selected month.  

 

 

View and Edit Organizer Account Information 

The My Account feature enables Organizers to view and edit their personal account information 
and to change their account passwords. 

! To view account information 

1. Log in to your Organizer Web site. 

2. In the left navigation bar, click My Account. 

The My Account Details page loads displaying Organizer account information. 

! To edit account information 

1. Log in to your Organizer Web site. 

2. In the left navigation bar, click My Account. 

The My Account Details page loads displaying Organizer account information. 

3. At the bottom of the My Account Details section, click the Edit button. 

4. At the top of the My Account Details section, enter your Current Password, make any 
desired account or password changes and click the Save Changes button at the 
bottom of the page. 
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View and Edit Organizer Account Billing Information 

The billing information feature enables Organizers to view and edit their GoToMeeting Personal 
Plan account billing information. 

Note: This feature only appears for GoToMeeting Personal Plan Organizers and does not apply to Corporate plan 
Organizers. 

 

! To view account billing information 

1. Log in to your Organizer Web site. 

2. In the left navigation bar, click My Account. 

3. In the left navigation bar, click Billing Information. 

The My Account: Billing Information page loads displaying Organizer billing information. 

! To edit account billing information 

1. Log in to your Organizer Web site. 

2. In the left navigation bar, click My Account. 

3. In the left navigation bar, click Billing Information. 

The My Account: Billing Information page loads displaying Organizer billing information. 

4. At the bottom of the My Account: Billing Information section, click the Edit button. 

5. Make any desired billing information change and click the Save Changes button at the 
bottom of the page. 

 

 

 

View Organizer Account Billing History 

The billing information history feature enables Organizers to view the history of all activity for 
their account billing information. 

Note: This feature only appears for GoToMeeting Personal Plan Organizers and does not apply to Corporate plan 
Organizers. 

 

! To view account billing information 

1. Log in to your Organizer Web site. 

2. In the left navigation bar, click My Account. 

3. In the left navigation bar, click Account History. 

The My Account: Account History page loads displaying Organizer billing information. 
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The GoToMeeting Organizer Application 
The GoToMeeting Organizer application enables Organizers to schedule meetings, view, edit 
and cancel scheduled meetings and access application preferences. 

Note: The GoToMeeting Organizer application must be installed on the computer being used to schedule and host 
meetings.  
 

Install the GoToMeeting Application 

The Organizer application must be on the computer in order to schedule and host meetings. 

! To install the Organizer application 

1. Open an Internet browser and go to www.gotomeeting.com.  

2. In the left navigation bar, click Log In. 

3. In the Returning Users section, enter your email address and password and click the 
Log In button. 

You will be logged in to your Organizer Web site and taken directly to the My Meetings 
page. 

4. At the bottom of the My Meetings page, click the re-install the GoToMeeting 
software link. 

5. On the Download GoToMeeting page, click the Download button. 

6. On the File Download dialog box, click Open. 

The GoToMeeting application downloads to your computer. 

7. On the GoToMeeting Installation dialog box, click Next and follow the onscreen 
directions to install GoToMeeting. 

8. Once installation is complete, click OK. 

The GoToMeeting application is installed on your computer; 
the GoToMeeting icon appears in your system tray and is 
ready for use. 

 

The GoToMeeting System Tray Icon 

The GoToMeeting system tray icon provides convenient access to all GoToMeeting functions. To 
access functions, simply right-click the system tray icon and select the desired function. 

 

 

 

Host a Meeting…
Enables the Organizer to start a

meeting from the system tray icon

Join a Meeting… 
Enables Attendees to join a meeting 
from the system tray icon 

My Meetings
Provides Organizers access to their

scheduled meetings and the ability to
add, edit or delete scheduled

meetings

Preferences 
Provides access to user preferences

Help 
Launches online help 

About
Provides GoToMeeting software

version information

Exit 
Closes the GoToMeeting application 



GoToMeeting™ User Guide 

© 2004 Citrix Systems, Inc. All rights reserved.  10 

Schedule a Meeting 

Organizers can schedule pre-planned meetings from the GoToMeeting system tray icon. 

! To schedule a meeting 

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. In the lower left of the My Meetings – GoToMeeting dialog box, click the Schedule New 
Meeting button. 

4. On the Schedule Meeting – GoToMeeting dialog box, enter: 

a. Meeting Subject – this is the name 
of the meeting. 

b. Meeting date. 

c. Meeting start and end times. 

d. Conference call information – this 
is the information Attendees will 
use to connect to the meeting by 
phone. You can chose to use a 
provided conference call number 
(toll fees will be charged to 
Attendees) or provide your own. 

e. Meeting password, if desired. 

5. Once meeting information has been 
entered, click the Schedule Meeting 
button. 

You will be notified your meeting has been 
scheduled. If you are using Microsoft 
Outlook, a meeting reminder will be 
generated and give you the option of 
inviting Attendees via an Outlook Calendar 
appointment. 

Note: Your meeting will keep showing in "My Meetings" until the midnight of the scheduled date. 

 

 

View Scheduled Meetings 

Organizers can view all scheduled meetings via the GoToMeeting application. 

! To view scheduled meetings via the GoToMeeting application 

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

The My Meetings - GoToMeeting dialog box appears listing all scheduled meetings. 
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Invite Attendees to a Scheduled Meeting 

An Organizer can invite Attendees to a scheduled meeting at any time prior to the start of the 
meeting. 

Note: For information on how to invite Attendees to a meeting already in progress, please see the Conducting 
Meetings section below. 

! To invite Attendees to a scheduled meeting 

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the My Meetings – GoToMeeting dialog box, select the meeting you want to invite 
Attendees to by clicking the name of the meeting in the Subject column, and click the 
Invite button. 

a. If you have an email application an email will automatically be generated with 
the meeting information included in the body text, simply send the email to 
attendees. 

b. If you do not have an email application, the Meeting Scheduled – GoToMeeting 
dialog box will appear, simply click the Show invitation text link to display the 
invitation information and on the Invitation Text – GoToMeeting dialog box click 
the Copy to Clipboard button and paste the invitation information into your 
email program or covey the information to attendees via any desired method. 

 

 

 

Edit a Scheduled Meeting 

Meeting Organizers can edit meeting information for a scheduled meeting at any time prior to 
the start of the meeting. 

Note: Changes to scheduled meetings will not be automatically updated in Microsoft Outlook or other calendar 
applications; neither will meeting Attendees receive notice of the meeting change from GoToMeeting. Please be sure to 
contact meeting Attendees directly to notify them of any changes to a scheduled meeting. 

! To edit a scheduled meeting 

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the My Meetings – GoToMeeting dialog box, select the meeting you want to edit by 
clicking the name of the meeting in the Subject column and then click the Edit button. 

4. On the Edit Meeting – GoToMeeting dialog box, make the desired changes to the 
meeting and click Save. 

5. Be sure to contact any previously invited Attendees to provide them with the updated 
meeting information. 
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Cancel a Scheduled Meeting 

Meeting Organizers can delete a scheduled meeting at any time prior to the start of the 
meeting. 

Note: Canceling a scheduled meeting will not be automatically updated in Microsoft Outlook or other calendar 
applications; neither will meeting Attendees receive notice of the meeting cancellation from GoToMeeting. Please be 
sure to contact meeting Attendees directly to notify them of a scheduled meeting’s cancellation. 

! To cancel a scheduled meeting 

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the My Meetings – GoToMeeting dialog box, select the meeting you want to cancel 
by clicking the name of the meeting in the Subject column and then click the Delete 
button. 

4. On the Meeting Deleted – GoToMeeting dialog box, click OK to confirm deletion of 
meeting. 

5. Be sure to notify any previously invited Attendees about the meeting’s cancellation. 

 

 

Impromptu Meetings 

Impromptu meetings are meetings that are not scheduled in advance. For more information 
about Impromptu meetings, please see the Conducting a Meeting section of this guide. 
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Set GoToMeeting Application Preferences 

GoToMeeting preferences allow Organizers to set preferences for running GoToMeeting, choose 
which GoToMeeting toolbars are displayed and test the GoToMeeting connection. 

 

! To set GoToMeeting preferences 

1. Right-click the GoToMeeting system tray icon and select Preferences. 

2. Select the appropriate tab for the set of preferences you want to customize – Start Up, 
Toolbars or Connect. 

3. Select your preferences. 

4. Click OK. 

 

 

Start Up Tab 

The Start Up tab enables Organizers to determine how to start GoToMeeting. Options include: 

• “Automatically after I log in to Windows” – This option starts GoToMeeting automatically 
after you log in to your PC. 

• “Manually” – This option sets GoToMeeting to start only when you launch the 
application from your Programs Menu. 

• Log in checkbox – This checkbox becomes available if you select “Automatically after I 
log in to Windows” and will enable automatic log in to the system. 

 

 

Toolbars Tab 

The Toolbars tab enables Organizers to determine where to display GoToMeeting toolbars. 
Options include: 

• “Show toolbar in Outlook” – This option displays the GoToMeeting toolbar in Microsoft 
Outlook. 

• “Show button in Messenger applications” – This option displays the GoToMeeting Quick 
Launch button in selected instant-messaging applications.  

Note: Changes may only be displayed after restarting Outlook and/or the instant-messaging application. 

 

 

Connection Tab 
The Connections Tab enables Organizers to test the status of the GoToMeeting connection. 

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a 
GoToMeeting Customer Care representative directs you to perform the connection test. 
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The GoToMeeting Outlook Bar 
The GoToMeeting Outlook Bar provides quick and easy access to GoToMeeting functions right 
from Microsoft Outlook. It includes the Meet Now and Schedule Meeting buttons, in addition to 
access to all the same features of GoToMeeting that the GoToMeeting system tray icon 
provides.  

 

Note: Outlook integration requires Microsoft Outlook 2000 or later. Outlook may need to be shut down and restarted 
for the GoToMeeting Outlook bar to appear. The GoToMeeting Outlook bar can be added or removed from the 
Preferences Menu. 

 

 

 

 

 

 

 

The GoToMeeting Messenger Button 
The GoToMeeting Messenger button provides a convenient way to start an impromptu meeting, 
right from your selected instant-messaging application.  

 

Note: Please see the Software Requirements section to check what Messenger products and version are supported. 
Messenger applications may need to be shut down and restarted for the GoToMeeting Messenger button to appear. The 
GoToMeeting Messenger button can be added or removed from the Preferences Menu Toolbars tab. 
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Conducting Meetings 
 

Notes on Conducting Meetings 
GoToMeeting Organizers start all meetings and one must be present before a meeting can 
begin. 

Organizers need to first create their accounts and download the GoToMeeting software on their 
computers before they can conduct meetings. 

Organizers invite Attendees and may do so via telephone, email or instant-messaging 
integration before a scheduled meeting or during a scheduled or impromptu meeting. 

Once a meeting starts, the Organizer becomes the meeting Presenter. During a meeting the 
Organizer may pass the role of Organizer or Presenter to other Attendees. 

 

 

 

Start a Scheduled Meeting 
Scheduled meetings are any GoToMeeting meetings that have been previously scheduled by 
the organizer in the GoToMeeting application.  

Scheduled GoToMeeting meetings can be started from the GoToMeeting system tray icon, the 
GoToMeeting Web site, the GoToMeeting Outlook bar. 

Note: To start a meeting, the GoToMeeting application must be installed on the PC being used by the meeting 
Organizer. For more information on installing the GoToMeeting application please see the GoToMeeting Organizer 
Application section of this guide. 

! To start a scheduled meeting from the GoToMeeting system tray icon 

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the My Meetings – GoToMeeting dialog 
box, select the meeting you want to start 
by clicking the name of the meeting in the 
Subject column and then click the Start 
button. 

Your meeting will start and the 
GoToMeeting Organizer Control Panel will 
appear on the right side of your desktop. 
For more information on the Organizer 
Control Panel see the Organizer Control 
Panel section below. 
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! To start a scheduled meeting from the GoToMeeting Web site 

1. Open an Internet browser and go to www.gotomeeting.com. 

2. In the left navigation bar, click Log In. 

3. In the Returning Users section, enter your email address and password and click the 
Log In button. 

4. On the My Meetings page, locate the scheduled meeting you wish to start and click the 
Start Meeting button. 

 

5. If prompted, click Yes or Grant to accept the GoToMeeting download. 

6. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 

 

 

! To start a scheduled meeting from the GoToMeeting Outlook bar 

1. From the GoToMeeting Outlook bar, 
click the GoToMeeting button and 
select My Meetings. 

2. On the Login – GoToMeeting dialog 
box, enter your Email address and 
Password and click Log In. 

3. On the My Meetings – GoToMeeting 
dialog box, select the meeting you 
want to start by clicking the name of 
the meeting in the Subject column, 
and click the Start button. 

4. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 
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Start an Impromptu Meeting 
Impromptu meetings are any meetings that an Organizer starts without first scheduling them 
in advance. This is an ideal feature for last-minute and on-the-fly meetings that need to occur 
without prior notice. Impromptu meetings may be initiated either from the GoToMeeting 
system tray icon or from an integrated instant-messaging application. 

Note: To start a meeting, the GoToMeeting application must be installed on the PC being used by the meeting 
Organizer. For more information on installing the GoToMeeting application, please see the GoToMeeting Organizer 
Application section of this guide. 

 

! To start an impromptu meeting from the GoToMeeting system tray icon 

1. Right-click the GoToMeeting system tray icon and select Host a Meeting. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the Host a Meeting – GoToMeeting dialog box, select Meet Now. 

4. On the Start a Meeting Now – GoToMeeting dialog box, enter: 

a. Meeting Subject – this is the name 
of the meeting. 

b. Conference call information – this 
is the information Attendees will 
use to conference into the meeting. 
You can choose to use a provided 
conference call number (toll fees 
will be charged to Attendees) or 
provide your own. 

c. Meeting password, if desired. 

5. Once meeting information has been 
entered, click the Start Meeting button. 

Your meeting will start and the 
GoToMeeting Organizer Control Panel will 
appear in the right side of your desktop. 
For more information on the Organizer 
Control Panel, see the Organizer Control 
Panel section below. 
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! To start an impromptu meeting from the GoToMeeting Web site 

1. Go to www.gotomeeting.com and click the Host a Meeting button. 

2. If prompted, click Yes or Grant to accept the GoToMeeting download. 

3. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

4. On the Host a Meeting – GoToMeeting dialog box, select Meet Now. 

5. On the Start a Meeting Now – GoToMeeting dialog box, enter meeting information and 
click Start Meeting. 

6. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 

 

 

! To start an impromptu meeting from the GoToMeeting Outlook bar 

1. From the GoToMeeting Outlook bar, 
click the Meet Now button. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the Start a Meeting Now – GoToMeeting dialog box, enter meeting information and 
click Start Meeting. 

4. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 

 

 

! To start an impromptu meeting from a Messenger application 

1. Launch the Messenger application. 

2. Open a chat communication with the attendee you would like to meet. 

3. On the side of the chat box, click the GoToMeeting Messenger Meet 
Now tab. 

4. On the Login – GoToMeeting dialog box, enter your Email address 
and Password and click Log In. 

5. On the Host a Meeting – GoToMeeting dialog box, select Meet Now. 

6. On the Start a Meeting Now – GoToMeeting dialog box, enter 
meeting information and click the Start button. 

7. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 
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The Organizer/Presenter Control Panel 
When the Organizer first joins the meeting the Organizer/Presenter Control Panel appears on 
the right side of the desktop. The Organizer/Presenter Control Panel gives the Organizer access 
to various Organizer and Presenter functions. The Organizer/Presenter Control Panel is 
comprised of four panes – Screen Tools, Attendee List, Chat, and Invite Others – and the Grab 
Tab. 

Note: When the Organizer passes the Presenter role to another Attendee, the Control Panel changes and the Screen 
Tools section is removed and given to the new Presenter. 
 

Note: Anytime the Presenter opens the Control Panel or uses the Grab Tab to access controls, invite others, use 
Attendee List, chat with Attendees or accesses either the 'Change Presenters' or 'Give keyboard control' menus from 
the Grab Tab, screen sharing to Attendees will be paused. Screen sharing will be automatically resumed once the 
Control Panel is minimized back to the side of the desktop or the mouse is removed from the Grab Tab. Therefore 
Presenters should not attempt to present information to Attendees anytime they are using these elements. 

 

 

Screen Tools Pane
Provides Organizers/Presenters with a visual
reminder of On Air status, the ability to show

their screens, pause showing their screens, pass
keyboard control and change Presenters

Attendee List Pane
Provides Organizers with a list of all meeting
Attendees and enables them to make other

Attendees Organizers or Presenters, grant or
revoke Attendee privileges and dismiss

Attendees

Chat Pane
Enables Organizers to chat with other

Attendees, either individually or all at once

Invite Others Pane
Provides information for Organizers to invite

Attendees to meetings via phone, email or
instant-messaging applications while

meetings are in progress

Grab Tab
Enables Organizers to minimize the Control

Panel to the side of their desktops to display
their full desktops to Attendees and still

access Presenter Screen Tools

Meeting Information
Provided for quick reference
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The Organizer Control Panel Menu Bar 

The Organizer Control Panel menu bar provides access to various application tools not 
specifically related to managing meetings. Menu options include File, Tools and Help. 

 

File Menu

The File Menu allows Organizers to edit how their names and 
email addresses are displayed to other Attendees, save the 

chat logs of their meetings as .txt files to their PCs, exit 
meetings without ending them (must first make another 
Attendee an Organizer) or exit meetings and end them. 

 

 

Tools Menu

The Tools Menu enables Organizers to allow or forbid bubble 
messages to appear when other Attendees chat or when 

GoToMeeting notifies them of system-related actions such as 
Attendees joining or leaving a meeting.  

 

 

Help Menu

The Help Menu provides access to the online Help file and  
GoToMeeting software version information.

 

 

 
 

The Organizer/Presenter Control Panel Grab Tab 

The Control Panel Grab Tab enables Organizers to minimize the Control Panel to the side of 
their screens to display their full desktops to Attendees and still access Presenter Screen Tools. 
The Grab Tab changes depending on the status of the Presenter role. 
 

 No 
Attendees 

have 
arrived 

Attendees 
arrived, 

presentation 
paused 

Attendees 
arrived, 

presenting 
desktop 

 Presenter 
controls 

passed to 
another 

Attendee 

Click and drag to move Grab 
Tab up or down 

Click and drag to move 
Grab Tab up or down 

Click to hide or display 
 Control Panel 

Click to hide or display 
Control Panel 

Shows On Air status 
Click to view presentation 

in Window Mode 

The Show My Screen button 
displays desktop to Attendees 

Click to view presentation 
in Full Screen Mode 

The Stop Showing Screen 
button pauses desktop display 

Click to pass Presenter 
role to another Attendee 

The Give My Keyboard button 
grants mouse/keyboard control 

to another Attendee 

Click and drag to move 
Grab Tab up or down 

The Change Presenters button 
passes the Presenter role to 

another Attendee 
 

Click and drag to move Grab 
Tab up or down 
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Manage Attendees 
Organizers can manage Attendees by right-clicking Attendee names in the Attendee Pane and 
selecting or deselecting the desired Attendee options. 

 

 

 

 

! To make an Attendee an Organizer 

Organizers can make an attendee an organizer to share control of a meeting or to let the 
first organizer leave the meeting and enable the meeting to remain in progress. 

• In the Attendee List, right-click the Attendee’s name and select Make Organizer. 

 

 

! To make an Attendee a Presenter 

• In the Attendee List, right-click the Attendee’s name and select Make Presenter. 

Or 

• On the Screen Tools Pane or the Grab Tab, click the Change Presenters button. 

 

 

! To enable an Attendee to share Organizer’s mouse and keyboard (when a Presenter) 

• In the Attendee List, right-click the Attendee’s name and select Allow Remote 
Control. 

Or 

• On the Screen Tools Pane or the Grab Tab, click the Give My Keyboard button. 

 

 

Assigns Attendee the role
of Presenter and/or

Organizer

Allows the Attendee to see the
list of other Attendees

Allows Attendee to control 
the Presenter’s keyboard 
and/or mouse 

Allows Attendee to chat

Sends a chat message directly
to the Attendee

Dismisses an Attendee 
from the meeting 
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Invite Attendees during a Meeting 

Organizers may invite new Attendees to meetings in progress from the Invite Others pane. 
Invitation methods include Phone, Email and Other. 

 

Invite Attendees by Phone

To invite Attendees by phone, expand the Invite 
Others pane and select the Phone tab. Call the 

desired Attendees and read them the information 
provided on the Phone tab. 

 

Invite Attendees by Email

To invite Attendees by email, expand the Invite 
Others pane, select the Email tab and then click the 

Email button. 

A new Microsoft Outlook email will be generated 
with the meeting invitation information in the body 
of the email; simply address and send the email to 

the desired Attendees. 

Note: The Email option only works with Microsoft 
Outlook. If you have another email program please 
chose the Other option to invite Attendees.  

 

Invite Attendees by Other Method

To invite Attendees using an email service other 
than Microsoft Outlook, expand the Invite Others 

pane, select the Other tab and then click the Copy 
button.

This will copy the meeting invitation information to 
your Clipboard, where it can then be pasted into 
another email program or an instant-messaging 

application.
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Chat with Attendees 
Organizers can chat with Attendees by using the built-in Chat feature in the Chat Pane. 

 

 

! To chat with Attendees 

1. Select the desired recipient(s) from the To: drop-down selection field. 

2. Enter desired chat message in the Message Entry field. 

3. Click the Send button. 

 

 

Present at a Meeting 
The Organizer who starts the meeting is also the initial meeting Presenter. For more 
information about presenting during meetings, please see the Presenting at Meetings section. 

 

Leave or End a Meeting 
Organizers may choose to either leave a meeting while allowing the meeting to continue or to 
end a meeting completely. 

Note: If an Organizer chooses to leave a meeting while allowing it to continue he or she must first designate another 
Attendee as the meeting Organizer. 

! To leave a meeting and allow the meeting to continue 

1. Prior to leaving the meeting be sure to make another Attendee the Organizer. 

2. From the File Menu, select Exit – Leave Meeting. 

3. On the Leave Meeting? confirmation dialog box, click Yes. 

Note: If you leave a meeting running that you started, you will not be allowed to host or join another meeting until 
the first meeting is finished.  

 

! To end a meeting 

1. From the File Menu, select Exit – End Meeting. 

2. On the End meeting for everyone? confirmation dialog box, click Yes. 

The Chat Log displays the
text of all public chat and

chat between two
Attendees

The To: field enables  
selection of chat 
recipients: choose All or  
a specific Attendee 

The Message Entry field
enables input of chat text

The Send button 
transmits chat to 
selected recipient(s) 
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Presenting at Meetings 
 

Presenter Role Overview 
The meeting Organizer is always enabled as the first meeting Presenter. The Presenter role 
may be passed to any meeting Attendee. 

Presenters show their complete desktops to all meeting Attendees. Presenters may choose to 
pause showing their desktops at any time. Presenters may grant other Attendees the ability to 
share the Presenter’s mouse and keyboard.  

Note: Anytime the Presenter opens the Control Panel or uses the Grab Tab to access controls, invite others, use 
Attendee List, chat with Attendees or accesses either the 'Change Presenters' or 'Give keyboard control' menus from 
the Grab Tab, screen sharing to Attendees will be paused. Screen sharing is automatically resumed once the Control 
Panel is minimized back to the side of the desktop and the mouse is removed from the Grab Tab. Therefore Presenters 
should not attempt to present information to Attendees anytime they are using these elements. 

 

 

The Presenter Screen Tools Pane 
When an Attendee becomes a Presenter, the Control Panel adjusts to incorporate the Presenter 
Screen Tools Pane at the top. The Screen Tools Pane provides the Presenter with access to the 
various Presenter controls. 

 

Presenter Screen Tools Pane when Off Air 

 

 

 

Presenter Screen Tools Pane when On Air 

 

 

 

The Broadcasting
Status light notifies

Presenters when they
are presenting their

desktops

The Show My Screen
button displays the

Presenters’ desktops
to Attendees

The Give My Keyboard 
button grants mouse and 
keyboard control to another 
Attendee 

The Change Presenters 
button passes the 
Presenter role to another 
Attendee 

The Broadcasting
Status light notifies

Presenters when they
are presenting their

desktops

The Stop Showing Screen 
button pauses display of 
Presenters’ desktops 
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The Presenter Control Panel Grab Tab 

The Control Panel Grab Tab enables Presenters to minimize the Control Panel to the side of 
their desktops to display their full desktops to Attendees and still access Presenter Screen 
Tools. The Grab Tab changes depending on the status of the Presenter role. 

 

 

 
Presentation 

paused  
Off Air 

Not Showing 
Screen 

Presenting 
desktop  
On Air 

Showing 
Screen 

Click and drag to move Grab 
Tab up or down 

Click to hide or display 
 Control Panel 

Shows On Air status 

The Show My Screen button 
displays desktop to Attendees

The Stop Showing Screen 
button pauses desktop display

The Give My Keyboard button 
grants mouse/keyboard control 

to another Attendee 

The Change Presenters button 
passes the Presenter role to 

another Attendee 

Click and drag to move Grab 
Tab up or down 

 

 

 

 

 

Use Presenter Controls 
When granted the Presenter role the Presenter Controls will appear at the top of your Control 
Panel. 

Note: Anytime the Presenter opens the Control Panel or uses the Grab Tab to access controls, invite others, use 
Attendee List, chat with Attendees or accesses either the 'Change Presenters' or 'Give keyboard control' menus from 
the Grab Tab, screen sharing to Attendees will be paused. Screen sharing is automatically resumed once the Control 
Panel is minimized back to the side of the desktop and the mouse is removed from the Grab Tab. Therefore Presenters 
should not attempt to present information to Attendees anytime they are using these elements. 

 

! To show the Presenter’s desktop 

• On the Screen Tools Pane or the Grab Tab, click the Show My Screen button. 

! To pause showing the Presenter’s desktop 

• On the Screen Tools Pane or the Grab Tab, click the Pause Showing Screen button. 

! To share the Presenter’s mouse and keyboard 

• On the Screen Tools Pane or the Grab Tab, click the Give My Keyboard button. 

! To change Presenters 

• On the Screen Tools Pane or the Grab Tab, click the Change Presenters button. 
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Attending Meetings 
 

Attendee Role Overview 
A meeting Attendee can be any person with an Internet connection. All that is needed to join a 
meeting is the meeting ID and, if required, the meeting password. Attendees do not need to 
subscribe to GoToMeeting; they meet at no cost to them, as guests of the Organizer. 

Attendees may be given the role of Organizer and/or Presenter from the original meeting 
Organizer at any time once a meeting has started. 

 

Join a Meeting 
There are several ways to join a meeting depending on how you receive the meeting invitation. 
Joining a meeting requires no pre-registration or software installation or configuration. 

Note: When joining a meeting, remember to also conference into the meeting using the conference call information 
provided by your meeting Organizer. 

! To join a meeting from an email invitation, Outlook meeting appointment or 
instant message invitation 

1. Open the email, appointment or instant message that contains the meeting invitation. 

2. Click the link provided in the email to join the meeting. 

3. If prompted, click Yes or Grant to accept the download. 

4. If requested, enter the meeting password provided by your meeting Organizer. 

You will be entered into the meeting and the Attendee Control Panel and the 
GoToMeeting Viewer Window will appear. 

! To join a meeting from the GoToMeeting Web site 

1. Open an Internet browser and go to www.gotomeeting.com. 

2. In the left navigation bar click the Join a Meeting button. 

3. If prompted, click Yes or Grant to accept the download. 

4. On the Join a Meeting – GoToMeeting dialog box, enter the Meeting ID you received 
from your meeting Organizer. 

5. If requested, enter the meeting password provided by your meeting Organizer. 

You will be entered into the meeting and the Attendee Control Panel and the 
GoToMeeting Viewer Window will appear. 

! To join a meeting from the GoToMeeting system tray icon 

1. Right-click the GoToMeeting system tray icon and select Join a Meeting. 

2. On the Join a Meeting – GoToMeeting dialog box, enter the Meeting ID you received 
from your meeting Organizer. 

3. If requested, enter the meeting password provided by your meeting Organizer. 

You will be entered into the meeting and the Attendee Control Panel and the 
GoToMeeting Viewer Window will appear. 
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GoToMeeting Attendee Application Components 
Once Attendees join a meeting they see two GoToMeeting Attendee components, the 
GoToMeeting Attendee Control Panel and the GoToMeeting Viewer Window. 

 

 

 

 

 

 

 

GoToMeeting Viewer
Window

GoToMeeting Attendee
Control Panel
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The Attendee Control Panel 
When Attendees first join a meeting, the Attendee Control Panel appears on the right side of 
their desktops and then minimizes to the side. The Attendee Control Panel gives Attendees 
access to various meeting functions. The Attendee Control Panel is comprised of two panes –
Attendee List, Chat and Invite Others – and the Grab Tab. 

 

 

 

 

 

Attendee List Pane
Provides a list of all meeting Attendees

Chat Pane
Enables Attendees to chat with other

Attendees, either individually or all at once

Grab Tab
Enables Attendees to minimize the Control
Panel to the side of their desktops and still

access Viewer tools

Meeting Information
Provided for quick reference
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The Attendee Control Panel Menu Bar 

The Attendee Control Panel menu bar provides access to various application tools not 
specifically related to attending a meeting. Menu options include File, View, Tools and Help. 

 

 

File Menu

The File Menu allows Attendees to edit how their names and 
email addresses are displayed to other Attendees, save the 

chat logs of meetings as .txt files to their PCs and exit 
meetings. 

 

 

View Menu

The View Menu enables Attendees to select how to display 
the Viewer Window on their desktops. 

 
Tools Menu

The Tools Menu enables Attendees to allow or forbid bubble 
messages to appear when another Attendee chats or when 

GoToMeeting notifies them of system-related actions such as 
Attendees joining or leaving a meeting.  

 

 

Help Menu

The Help Menu provides access to the online Help file and to 
GoToMeeting software version information.

 

 

 

 

The Attendee Control Panel Grab Tab 

The Attendee Control Panel Grab Tab enables Attendees to minimize the Control Panel to the 
side of their desktops. The Grab Tab changes depending on the status of the Viewer Window. 

 
 Attendee 

Grab Tab 
with 

Viewer in 
Window 

Mode 

Attendee 
Grab Tab 

with 
Viewer in 

Full 
Screen 
Mode 

Click and drag to move 
Grab Tab up or down

Click to hide or display 
Control Panel

Click to view presentation  
in Window Mode 

Click to view presentation 
in Full Screen Mode 

Click and drag to move 
Grab Tab up or down
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Chat with Other Attendees 
Attendees can chat with other Attendees by using the built-in Chat feature in the Chat Pane. 

 

 

 

! To chat with Attendees 

1. Select the desired recipient(s) from the To: drop-down selection field. 

2. Enter desired chat message in the Message Entry field. 

3. Click the Send button. 

 

 

The Chat Log displays the
text of all public chat and

chat between two
Attendees

The To: field enables 
selection of chat 
recipients; choose All  
or a specific Attendee 

The Message Entry field
enables input of chat text

The Send button 
transmits chat to 
selected recipient(s) 
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The GoToMeeting Attendee Viewer Window 
The Viewer Window is where the image of the Presenter’s desktop is displayed to Attendees. 
The Viewer displays the Presenter’s complete desktop and places a privacy cover over the 
Presenter’s Control Panel and Grab Tab. The Viewer Window can be displayed in either a 
Window Mode or a Full Screen Mode. 

 

 

GoToMeeting Viewer 
Window in Window Mode, 
with Presenter’s Control 

Panel minimized. 

 

 

GoToMeeting Viewer 
Window in Full Screen 
Mode, with Presenter’s 

Control Panel minimized 
and the Attendee Control 
Panel Grab Tab available. 

 

Note: When Presenters 
maximize their Control 

Panels the privacy cover 
again appears as it does 
with Viewer Window in 

Window Mode. 

 

Viewer Window in 
Window Mode 

Privacy cover over 
Presenter’s Grab Tab 

Viewer Window in 
Window Mode 

Privacy cover over 
Presenter’s Grab Tab 

Attendee Grab Tab



GoToMeeting™ User Guide 

© 2004 Citrix Systems, Inc. All rights reserved.  32 

Configure the Viewer Window 

The Viewer Window may be configured to display in either Window mode or Full Screen mode. 

! To display the Viewer Window in Window mode 

• From the Attendee Grab Tab, select the Window Mode button. 

Or 

• From the Attendee Control Panel View Menu, select Window. 

 

! To display the Viewer Window in Full Screen mode 

• From the Attendee Grab Tab, select the Full Screen Mode button. 

Or 

• From the Attendee Control Panel View Menu, select Full Screen. 

 

 

 

Share Presenter Mouse and Keyboard 
At any time during a meeting Presenters may share control of their mouse and keyboard with 
any other Attendee to enable that Attendee to share control of applications on the desktop 
being displayed. 

When an Attendee is given shared control, the 
GoToMeeting application notifies all Attendees of 
the change in control by providing a System 
Bubble Message. 

 

Note: Even though an Attendee may gain shared mouse and keyboard control of the Presenter’s desktop, the 
Presenter always retains overriding control. 

 

 

 

Become a Presenter 
At any time during a meeting the Presenter may pass the Presenter role to any other Attendee 
to enable that Attendee to share his or her desktop with the other Attendees. 

When an Attendee is made a Presenter the 
GoToMeeting application shows a dialog box 
notifying the Attendee that he or she has been 
made Presenter and updates his or her Control 
Panel and Grab Tab with Presenter Tools. 

For more information about being a Presenter, 
please see the Present at a Meeting section. 
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Become an Organizer 
At any time during a meeting the Organizer may pass the role of Organizer to any other 
Attendee to enable that Attendee to take over or share in meeting management functions. 

When an Attendee is given shared control the 
GoToMeeting application notifies the Attendee of 
the change by providing a System Bubble 
Message and updates his or her Control Panel 
and Grab Tab with Organizer Tools. 

For more information about being an Organizer, 
please see the Organizer/Presenter Control Panel 
and Manage Attendees section. 

 

 

 

Leave a Meeting 
An Attendee may leave a meeting at any time. 

! To leave a meeting 

• From the Attendee Control Panel File Menu, select Exit – Leave Meeting. 

• On the Leave Meeting? confirmation dialog box, click Yes. 
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Tips for Meeting Success 
 

• Clean up your desktop before a meeting. Eliminate wallpaper and icons that may 
distract your Attendees. 

• Have the documents you wish to share ready to be accessed in one or two clicks. 

• Run a trial meeting with a friend to anticipate questions and to familiarize yourself with 
the format of your online presentation. 

• Start on time. 

• Encourage participation by using open questions such as “What would you suggest?” 
and “How do you feel about…?” 

• Always use GoToMeeting for your online meeting needs! 

 

 


